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How to Install MAPPER System for Windows 
Evaluation Version 

You install the MAPPER System for Windows Evaluation Version using a setup program on the first 
diskette. This is done from the Program Manager in Windows. 

To install the MAPPER System for Windows see : Getting Started document 

How to Install MAPPER LoB Demos 

There will be 6 diskettes in this set. ( Purple labels) These are the line of business MAPPER Demos. 
These demos are all loaded separately but use the same instructions : 

Quantas Demo 	2 diskettes 
Mapcon Demo 	1 diskette 
Unipd 	Demo 	1 diskette 

Digi-view Demo 	1 diskette 

AES 	Demo 	1 diskette 

To load these Demos : 1. Insert diskette into Drive A or B 
2. Sign on to MAPPER for Windows 
3. From the menu bar: select File, select Application, select Import 
4. Enter Application Name (e.g. Quantas,Mapcon,Unipd Digi-Viewor AES) 
5. Select LOB types for each application as you load it. 

( Quantas select Transportation) 
( Mapcon select Miscellaneous) 
( Unipd select Goverment ) 
( Digi-view select Communications) 
( AES 	select Micellaneous) 

6. Choose OK Button 
Your application will now load into the next available cabinet and drawer. When the load is complete 
you can select Application from the menu then choose your application and it will execute . When 
your application is finished you will be returned to the main demo system menu. 

How to Install the PowerPoint presentations 

Ther will be 1 diskette (light blue label) in this set. This diskette has 2 powerpoint presentations 
compressed on one file called infotool.exe 

To load these Presentations: 

LL  

MAPPER 
1>›, 

1. From Windows File Manager 
2. Copy a:\infotool.exe to your hard drive powerpoint directory 
3. Execute infotool.exe this will explode the 2 powerpoint files 

into your powerpoint directory 
4. Select Info.ppt or maptool.ppt from either powerpoint 

or from the slide show menu selection in MDS. 
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About this Guide 

Purpose 

This guide describes how to install the MAPPER System for Windows Evaluation Version. It includes 
information on hardware and software requirements, starting and quitting the MAPPER system and 
installing the online books and using the online help system. 

Scope 

This guide provides installation information and an introduction to the MAPPER System for Windows 
Evaluation Version. For complete information on the MAPPER System, see the Classic MAPPER User's 
Guide or the online books. 

Audience 

This guide is intended for those installing and using the MAPPER System for Windows Evaluation Version. 

Prerequisites 

This guide assumes you have set up and installed Microsoft Windows version 3.1 and are familiar with the 
basic terminology and procedures for using Microsoft Windows. If you are not familiar with using a mouse 
and performing fundamental tasks with Microsoft Windows, consult your Microsoft Windows documentation 
before you begin working with the MAPPER system. 

Styles and Conventions 

Text in bold indicates information you enter. Unless specified otherwise, you may enter the text in either 
upper- or lowercase. 

Organization of This Guide 

This guide includes two sections. Here is a summary of each section: 

Section 1. Installing the MAPPER System for Windows Evaluation Version 

This section discusses the hardware and software requirements for installing the MAPPER System 
for Windows Evaluation Version. It also describes the dialog boxes you see as you go through the 
setup program. 

Section 2. Accessing Online Help and the Utilities 

This section discusses how to access the online help, the online books, and the MAPPER utilities. 
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Related Product Information 

In addition to this guide, the MAPPER System for Windows library includes the Classic MAPPER User's 
Guide and several online documents. Your familiarity with MAPPER software and using Microsoft 
Windows will determine how you use your documentation. 

Here is a summary of the MAPPER System for Windows documentation: 

Online Documents 

During the installation, you have the opportunity to check a box if you would like to install the online books. 
By installing the online books, you can access several manuals online to read or print. If you would like a 
printed copy of any of the online books, see the MAPPER System for Windows Software Release 
Announcement for ordering information and for a complete description of the MAPPER library. Here is a 
summary of the online manuals: 

MAPPER Command Reference (7832 0769) 
Short title: Command Reference 

This reference describes MAPPER manual functions, run statements, and many of the released runs. 

Classic MAPPER User's Guide (7832 0751) 
Short title: Classic MAPPER User's Guide 

This guide describes how to use the MAPPER system with the classic MAPPER (character based) interface. 
It provides background information regarding the MAPPER system database structure, setting up reports, 
writing runs, and so on. 

MAPPER System for Windows Administration Guide (7832 1254) 

This guide describes how to manage your system including information on accessing other MAPPER 
systems, using the MAPPER support utilities, and day-to-day administration activities. 

For more information on how to access these online books, refer to Section 2. 
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Section 1 
Installing MAPPER System for Windows 
Evaluation Version 

This section describes how to install the MAPPER System for Windows Evaluation Version. It details what 
you need to run the MAPPER system, including hardware and software requirements. 

This section includes: 

• What you receive 

• Requirements for the MAPPER system 

• How to install the MAPPER system 

What You Receive 

With the Mapper System for Windows Evaluation Version, you receive the following: 

• Set of 3-1/2-inch high density diskettes 

• Limited-Term Product Evaluation Agreement 

The diskettes are labeled in the order in which you install them. Table 1-1 shows the amount of disk space 
required for each component. 

Table 1-1. Components and Disk Space Required 

Component Megabytes of Disk 
Space Required 

MAPPER System for Windows 19.6 
Online books (optional) 2.7 
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Requirements for MAPPER System for Windows 
Evaluation Version 

To install and execute the MAPPER System for Windows Evaluation Version, you need the following: 

• Microsoft Windows version 3.1 or Microsoft Windows for Workgroups version 3.11. 

• 386 (or higher) personal computer (PC). 

• MS-DOS version 5.0, 6.0, or 6.2. 

• The SHARE.EXE program supplied with DOS 5.0 and DOS 6.0 executed prior to installation. You 
run the SHARE.EXE program by including a statement in your AUTOEXEC.BAT file (or the 
equivalent file for your system) similar to the following: 

C:\DOS\SHARE.EXE 

You must reboot your system after you add the statement to your AUTOEXEC.BAT file. 

• 8 Mbytes (or more) memory. 

• 20 Mbytes (or more) hard disk space available. 

• Novell LAN Workplace for MS-DOS level 4.01, 4.10, or 4.10B (required for networking only). 
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How to Install MAPPER System for Windows 
Evaluation Version 

You install the MAPPER System for Windows Evaluation Version using a setup program on the first 
diskette, This is done from the Program Manager in Windows. 

To install the MAPPER System for Windows: 

1. Start Windows, if you have not already done so. 

2. Open the Program Manager. 

3. Select the File menu. 

4. Select Run. 

5. Insert the MAPPER System for Windows Evaluation Version diskette 1 into drive A (or drive B). 

6. Type a:\setup (or b:\setup) and press Enter. 

The first dialog welcomes you to the MAPPER System for Windows setup. If you choose continue, the 
MAPPER System for Windows installation dialog is displayed. This dialog asks you to specify a directory. 
The default directory is C:\MSW. This dialog also provides you with the opportunity to install the online 
books. If you do not want the online books installed, remove the check from the box by clicking on it. For 
more information about the online books, refer to Section 2. 

Now, follow the instructions displayed on your screen. You are prompted when to insert each diskette. Do 
not remove a diskette from the drive until you receive the prompt to insert the next diskette. 

During the installation process, you have the opportunity to exit at any time. If you choose to exit, a message 
is displayed stating that the MAPPER system for Windows was not properly installed. If you exit the 
installation before it is complete, you need to remove product files that are already loaded. Refer to 
"Removing MAPPER System for Windows Evaluation Version" for a procedure on how to do this. 

The files on the diskette are compressed, so there are pauses during the setup procedure as the files are 
decompressed to the hard disk. These pauses are normal. 

When the MAPPER database installation is complete, the Program Manager window is displayed with the 
addition of a new Unisys MAPPER System program group. 
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Troubleshooting the Installation 

If there is a problem with the installation, the setup program stops and a message displays informing you that 
the installation was not successful. Here are the messages and the possible solutions: 

Message 

"Setup has detected that SHARE.EXE is not running and therefore cannot continue" 

Cause 

The SHARE.EXE statement is missing from your AUTOEXEC.BAT file (or the equivalent file for your 
system. 

Solution 

Follow the procedure for adding the SHARE.EXE file described earlier in this section under "Requirements 
for the MAPPER System." 

Message 

"Setup was not successful. Refer to the Getting Started Guide for a possible cause" 

Cause 

Check to whether you have the SHARE.EXE statement in your AUTOEXEC.BAT file (or the equivalent file 
for your system). If that is not the cause, it could be due to a memory conflict from another application 
currently running or an application you removed that did not release its resources properly. 

Solution 

If the message displayed because the SHARE.EXE statement is missing from your AUTOEXEC.BAT 
follow the procedure for adding the SHARE.EXE file described earlier in this section under "Requirements 
for the MAPPER System." 

If the message displayed because of a memory conflict or another unexplained reason, follow this procedure: 

1. Check to see whether there is sufficient space available on the drive on which you are installing 
MAPPER System for Windows. 

2. Remove any files and directories specified during the previous installation. See "Removing 
MAPPER System for Windows Evaluation Version" later in this section for a procedure on how to 
do this. 

3. Try the installation again with no other applications running. 
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Starting the MAPPER System for Windows 
Evaluation Version 

Follow this procedure to start the MAPPER System for Windows: 

1. With the Unisys MAPPER System program group displayed, use your mouse to double-click on the 
MAPPER for Windows icon or use your arrow keys to highlight the MAPPER for Windows icon 
and press Enter. 

2. A dialog box is displayed welcoming you to the MAPPER System for Windows. You are also 
prompted to enter a preferred user-id. 

3. Enter your preferred user-id. The MAPPER system assumes this user-id every time you start the 
MAPPER System for Windows, so you are not prompted to enter a user-id every time you call the 
MAPPER system. 

4. The MAPPER Demonstration System (MDS) application is automatically started. From the main 
MDS menu, you can view a number of built-in demonstrations and create your own slide shows. 
See MDS online help for more information. 

Notes: 

• The transmit or execute command key in MAPPER System for Windows is the Enter key on the 

numeric keypad. 

• If you are Designer Workbench (DW) user and you want to start MAPPER System for Windows 
without connecting to your DW repository, add the following statement to the section titled 
[MAPPER] in your WIN.INI file: 

MWURepInhibit=1 
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Removing MAPPER System for Windows 
Evaluation Version 

To remove MAPPER System for Windows software from your PC 

1. From the Program Manager, delete the Unisys MAPPER System program group. 

2. Use your preferred text editor to open your WIN.INI file. Remove the MAPPER application 
section from the Windows WIN.INI file. Here is an application section with default values: 

[MAPPER] 
MWRoot=C:\MSW 
MWDataDir=C:\MSW\REP 
MWScreenFile=CAMSW\MAPPER.MSF 
MWData=C: \MSW \DB 1 \MSTR 

3.. Delete all directories containing MAPPER System for Windows. The default root directory is 
C:\MSW. 

4. 	Delete the file HDKCTNTS.DLL (and HDKCTNTS.INI if it exists) from your Windows 
directory. 
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Section 2 
Using the MAPPER System 

This section describes how to use the online help system and how to access the utilities. 
This includes: 

• Using the online help 

Accessing the utilities 

Using the Online Help 

MAPPER System for Windows offers a combination of both menu bar and character-based capabilities, with 
online help available in both environments. Here is a list of the types of online help available to you: 

• Context-sensitive help for run statements 

• Online books accessible two ways: 

- From the HELP run while you are using the MAPPER system 

- From icons in the Windows Program Manager 

• Menu bar online help 

• MAPPER utilities online help 

Context-Sensitive Help 

To display context-sensitive help about a run statement 

1. Type help4run-call in the control line (for example, help,@sor). 

2. If no report is on display, the detailed online help is displayed as a Windows help topic. 

3. If a report is on display, the run statement syntax is displayed. 

4. If the run statement syntax is displayed, press Fl to display the detailed online help for the run 
statement requested. 

5. The help is displayed as a Windows help topic. 
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Online Books 

There are several ways to access the online books. While you are using the MAPPER system you can access 
them from either the help run or the Help menu. You can also access the books directly from the Windows 
Program Manager by double-clicking on the icon of the book you want to access. 

• To display the online books using the help run 

Type help,command on the control line (for example, help,tot). 

If the command is a valid MAPPER function or run statement name, detailed online help is 
displayed as a windows help topic. 

If an invalid or incomplete command is entered, the Windows Help Search dialog is displayed. 

• To display the online books from the Help menu 

Choose Contents from the menu bar Help menu. 

Select the book of your choice from the online books category. 

• To display the online books from the Windows Program Manager 

Double-click on the icon of the desired book from the Windows Program Manager. 

Exiting from the MAPPER system does not close the online books. You must close the online books 
independently. 

Menu Bar Help 

• To display help about the menu bar 

1. Choose Contents from the Help menu. 

2. Select the help topic category of your choice. Help topic categories include the commands that 
are accessible from the menu bar, dialogs, and procedures. 
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MAPPER Utilities Help 

There are two procedures you can use to access help for the MAPPER utilities 

• Choose Contents from the menu bar Help menu. 

• Select MAPPER Utilities help from the help topic categories. 

Double-click on the MAPPER utilities help icon from the Windows Program Manager. 

Note: Help for the MAPPER utilities is also available while you are using the MAPPER utilities. 

Accessing the Utilities 

The utility program contains some diagnostic tools, manual restart capabilities for recovery purposes, and 
database maintenance functions. To access these utilities, double-click on the MAPPER Utilities icon from 
the Unisys MAPPER System program group. See the MAPPER System for Windows Administration Guide 
or the online help system for instructions on using these utilities. 
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Section 1 : Introduction 

The purpose of this demo system is to provide the field and customers with an easy, 
consistent way to experience and demonstrate capabilities available TODAY using The 
MAPPERSystem. 

One of the most difficult challenges that Unisys faces is developing and retaining 
the expertise required to quickly and effectively demonstrate the unique features 
of our products. To further complicate matters, the demos are usually constructed and 
organized in a haphazard manner, and are not complete from start to finish. 

This package is the nucleus for a set of "Demonstrations" which highlight the capabilities 
we offer today. This package is intended to not only provide demos and instructions on 
"how to" demo but to allow the addition of new functionality presentations as they 
become available. Once people have been trained to use the demo system, they should be 
able to include "new " features, slide presentations and applications as they are released, 
to the demo nucleus 

Via this nucleus we will also be able to organize the MAPPER System on demo 
platforms more logically and effectively. When reviewing this package the user will find 
that each demo is stored in a particular area within MAPPER and is referenced by an 
initial menu, which can be added to or deleted from the system, as needed. 

In addition, this package includes "slide presentations" which can be executed via 
MAPPER. These slide presentations are to be used as marketing tools for MAPPER 
opportunities. This is not intended to replace standard 35 mm slide sets which will still 
be produced, but to provide additional marketing collateral via a unique Mapper 
capability of slide presentation. This capability can be especially useful for internal 
sessions including training. For instance, one of the slide sets enclosed shows MAPPER 
as the Information Tool set for Client / Server Applications. The Slide presentations 
which are included may be accessed from the main menu.of the Demo System 

3 
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Section 2: MAPPER an Information Access,Analysis & Reporting Tool 

The 1980's saw the introduction of the term "Executive Information Systems". The basis 
for this concept was that while the DP department produced databases and the 
applications that fed them, using that captured data to produce information to help run the 
company or business was a different flavor of computer application. This EIS application 
was required to discover trends or anomalies in existing data. EIS could be used to 
monitor and measure the performance of various aspects of a business as related to the 
executives. 

One of the characteristics of an EIS was to display this information in graphical format, 
something more readily understood than computer printouts. Also implied here is the 
option to have a live feed from a database, (an interface). The reason for this is to be 
certain that, if required, you can directly interface with the current data. 

Decision Support Systems was yet another flavor of systems that would provide some 
tools and/or functions for manipulating data, for asking the data "What if 	 ?" These 
DSS systems would also help with forecasting, reporting, modeling, etc. End User 
Computing is another term which indicates some NON_DP usage of computers. Again 
the idea is to provide easy-to-use tools and/or functions for use by people who know their 
job but aren't computer genius'. 

Due to the constant change in the business climate, today's organizations are rationalizing 
their management processes to achieve a flatter and more flexible management structure. 
The goal of flatter management structures is to drive the corporate strategy to all layers of 
management and to implement it through well-defined management responsibilities and 
more clearly defined objectives. While support for the core business applications is 
important, using technology to support the management process is the obvious next step. 

MAPPER as an Information Access, Analysis and Reporting Tool meets all of the above 
needs, supporting all the different levels of management. MAPPER can be defined as a 
cross-functional information system for use by all levels of management. 

4 
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Version 1.1 

Section 3: What can I do with these Demos ?  

The best demonstration of any software is an application which solves a customer 
problem and uses the customer's data. As we are all aware, this is not always feasible. 

THE BEST DEMO IS AN APPLICATION WHICH SOLVES A SPECIFIC, 
CUSTOMER STATED PROBLEM AND IS SUPPORTED BY CUSTOMER 
DATA ! ! ! 

Again this is not always possible. This Demo System is meant to supplement demos 
which directly solve a customer problem using their data. These demos are meant to 
supply the field with a canned and generic set of MAPPER applications. These can be 
used for internal and customer sessions. The intention is twofold. One is to keep from 
reinventing the wheel in each geographic location and at the same time ensure that all the  
important features of the system are represented. The other is to put into place a "nucleus" 
set of applications which are well organized and can be enhanced to include new 
capabilities as they are released. 

With a standard set of demos, isolating a particular problem is easier, and when asking 
questions concerning them we will all be talking about the same thing! 

In situations where the customer already uses MAPPER, the demos can be utilized for 
marketing the new software levels and generate new ideas for developing or enhancing 
applications. 

As the demos reflect certain fundamental characteristics of evolving technologies (e.g. 
Client/Server, Multi-Media), they also present an opportunity to show some leading edge 
capabilities that Unisys can deliver today to existing non-MAPPER customers as well. 
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Section 4: System Overview 

The MAPPER Demonstration System is an integrated set of facilities that help you 
demonstrate .MAPPER software. With MDS, you use MAPPER to show MAPPER 
capabilities. This is a proven, effective way to communicate the power and versatility of 
the MAPPER system. 

MDS provides three main functions: 

• Slide Shows 

MDS lets you create and view slide shows composed of pictures, MAPPER 
applications, 
GUI examples, and/or Microsoft PowerPoint slides or slide shows. 

The initial MDS environment contains a number of pictures, applications and GUI 
examples for you to use in your slide shows. Through MDS, you can import other 
pictures, applications and PowerPoint slides, and use them as part of slide shows 
you create. 

• Applications 

The initial MDS environment contains a number of applications that showcase 
MAPPER capabilities such as Picture Processing, Business Graphics, etc. You may 
execute these applications through the MDS menu system either by name or line of 
business, or you can select an icon from the MDS toolbar. 

In addition, you can create your own MAPPER applications and use the MDS 
import facility to make them part of the MDS menu system and your slide shows. 
MDS also has an export facility to copy imported applications to diskette, so you 
can easily distribute them to others. 

• Graphical User Interface (GUI) Examples 

The GUI Examples demonstrate many different types and styles of MAPPER GUI 
screens. They include buttons, list boxes, and several other GUI objects. The 
examples can be viewed individually, or you may include them in slide shows you 
create. 

Also available is a demonstration version of the MAPPER Quick Screen product, a 
utility that lets you easily and rapidly build MAPPER GUI screens. 
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New In MDS Version 1.1 

If you previously used MDS version 1.0, you'll notice several improvements. 
Version 1.1includes these 
enhancements and more: 

• A toolbar, with icons for easy access to the built-in MDS applications. 

• An "Explain" command on the Help menus of all built-in MDS applications and GUI 
Examples. This new feature describes the purpose of each demonstration and how to 
operate it. 

• Improved user interfaces on all built-in MDS applications and GUI Examples. 

• Links from all GUI Examples to screens that describe the related run statement (like 
@BTN) in much more detail, with further links to MAPPER online Command 
Reference help. 

• The newest version (1.1) of the MAPPER Quick Screen Utility, with improved font 
selection and many other enhancements. 

• Help by topic availability from the main MDS menu. 
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MDS Facilities 
• Create Slide Show 

Use this facility to create a new slide show, which can consist of pictures, 
applications, 
GUI Examples, and/or PowerPoint slides or slide shows. When you create a slide 
show it is automatically added to the MDS menu system. 

• Modify Slide Show 
Use this facility to modify a slide show you previously created. 

• Delete Slide Show 
Use this facility to delete a slide show you previously created. 

• Import Picture 
Use this facility to import a Windows Bitmap (.BMP) file or PC Paintbrush (.PCX) 
file. The file you specify will be uploaded to the MAPPER database. You may then 
use the picture in a slide show. 

• Modify Picture 
Use this facility to modify a picture that is already loaded in MDS. 

• Export Picture 
Use this facility to copy a .BMP or .PCX picture from MDS to diskette. 

• Remove Picture 
Use this facility to remove a picture from the MDS menus and the MAPPER database. 

• View Picture 
Use this facility to view a picture that was previously loaded in the MDS database. 

• Import PowerPoint Slide Show 
Use this facility to import a PowerPoint slide show. The (.PPT) file you specify will be uploaded to the 

MAPPER database and added to the MDS menu system. You may then call it as a 
stand-alone slide show, or make it part of another slide show you create. 

• Modify PowerPoint Slide Show 
Use this facility to modify a PowerPoint slide show that is already loaded in MDS. 
You must have the Microsoft PowerPoint product installed on your PC to perform 
this function. 

• Export PowerPoint Slide Show 
Use this facility to copy a PowerPoint slide show from MDS to diskette. 

8 
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• Remove PowerPoint Slide Show 
Use this facility to remove a PowerPoint slide show from the MAPPER database and 
MDS menus. 

• Import MAPPER Application 
Use this facility to either load a MAPPER application from diskette, or to register an 
existing MAPPER application with MDS. This lets you execute the application from 
the MDS menus and include it in slide shows you create. 

• Export MAPPER Application 
Use this facility to copy a MAPPER application to diskette. The application must 
have been previously registered with MDS to export it. 

• Remove MAPPER Application 
Use this facility to remove a MAPPER application from the MDS menus. The 
application will not be deleted from the MAPPER database. 

9 
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System Requirements 

• MS Windows 3.1 or MS Windows for Workgroups 3.11 

• Mouse or some other pointing device 

• MAPPER platforms supported: 

- MAPPER System for Windows level 1.0 

- MAPPER System for UNIX level 4R2/4R3 or higher with Designer Workbench 
2R1A or 3R1B 

- MAPPER System for 2200 level 36R1 or higher with Designer Workbench 2R1A or 
3R1B 

- MAPPER System for A-Series 4R2 or higher with Designer Workbench 2R1A or 
3R1B 

• 386 or higher CPU 

• Minimum Memory Requirements: 

- 8 MB for MAPPER System for Windows 

- 4 MB for Designer Workbench 

• VGA monitor 

- 256 Colors recommended 

- Standard VGA resolution ( 640 x 480) recommended 

• 5.4 MB MAPPER database space available 

• Microsoft PowerPoint (optional) 

• Microsoft EXCEL (optional) 
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Installation 
If you have an Evaluation copy of MAPPER for Windows, MDS is already installed. 

If you are using tthe MDS Diskette set to install on an existing licenced MAPPER system 
use the following instructions 

1. Start Windows. 

2. Open MAPPER session ( either MAPPER System for Windows or Designer 
Workbench ). 

3. Sign onto MAPPER with a User-ID that has coordinator privileges (such as 
MAPCOORD,2 ). 

4. Insert MDS disk 1 into drive A ( or B ). 

5. If you are using MAPPER System for Windows 1.0, MAPPER System for UNIX 
5R1 or MAPPER System for 2200 37R1 execute the SETUP run. On MAPPER 
System for Windows, you must select the "Custom Application" option. 

- or 
If you are using an earlier level of MAPPER, or you do not have access to the 
SETUP run, you must create and execute your own SETUP run containing the 
following statements. Register this run with 99999 I/Os and LLPs: 

@PCR,O,A,-0 A:\SETUP.RUN . (or B: if drive B) 
@RNM -8 . 
@CALL,-8 00010 . 

6. If you are installing MDS for the first time, you must specify an empty cabinet to 
load into. The lowest empty cabinet number is chosen for you as the default. The 
SETUP run automatically generates the drawers required to contain the MDS runs 
and data. 

If MDS is already installed on your system, the SETUP run will ask you if you 
want to overlay your existing version, or install a second copy. If you choose to 
overlay your existing version, the SETUP run will preserve your slide shows, as well 
as any pictures and applications you imported. 

7. Load the remaining MDS disks when prompted to do so. 

Upon completion of the installation process, the MAPPER Demo System will be 
registered as a MAPPER run called MDS in the master department. 
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